Log In

Log into http://streaming.discoveryeducation.com/index.cfm and choose a service -
Discovery Education™ streaming or Discovery Education Science — Middle School or
Elementary School.

My Services

Discovery Education streaming —

Ergage students today with awe-inspiring video and other classraarm
resources. Custamize and personalize lessons to different subjects,
grades, and learning styles using an interactive World Atlas, cormpelling
videa clips, writing prompts, and more. Go now!

Discovery Education Science

,r& Access aclassroom resource to supplerment what wou are teaching this
"-.;,4 week, Simply search the topic, find the resource, and inspire your
technology-savy students.
Investigate like a real scientist by Explore science while reinforcing
learning science process skills. literacy and mathermatics skills.
Go now! Go now!

Discovery Education™ streaming

Search a video by keyword search, or use the “drill down” by clicking on a media type,
subject, grade, or by curriculum standard.

My DE DE Sclence

Discovery
<% “_EDUCATION
St eaming' Search | within  FAl Content i~

Sdvanced Search ‘: All Content

F =
‘ Welcome, Sookhee \ideo Segmients eacher Cer|

Anticles
| Audio

Clip Ant
Events
« Images

| Lesson Plans
| Quizzes

> | Songs

E { | Sound Effects
| Speeches

Subject/Grade Search
e

BY SUBJECT
» Careerswork Place Skills

+ EnglishjLanguage Arts
» Health

» Mathematics

» Research/Study Skills
+ Science

» Social Studies
» Teaching Practices

, Wisual and Performing
Arts

» World Languages
»K-2
*»3-5
*6-8
*9-12

MORE TO SEE. ko

Curriculum
Standards Search

State/Province
Maryland
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Click on the video you want to view and then you will see Play/Add this clip to the
queuve/Download options. You can also click ADD to add the video to My Content
(playlist). The options are explained below.

Science Fiction

A segment of Discovering Language Arts: Fiction (Grades 6-8)

v

v» k Discovering Language Arts: Fiction
{Grades 6-8) (1:16:48)

-

|»

» ¥ kal Science Fiction (03:46)

» ¥ fl The Real Great Gatsby (05:50)

» ¥ |l The Plot Thickens (07:15)

» ¥k Developing Character Through Courage (06:07)
» ¥l Inference and Drawing Conclusions {05:32)

» ¥ kl Literary Devices: It's Elementary {(07:27)

ouery » ¥ |l Boris the Lifeguard (04:31)

EDUCATION » & kA Civil Rights Poem {06:29)

o I e o 8 O

> ) You've Got Style (06:19)

|
Add To IMJ.,l Content vI m

Download v

Media Settings

Add this clip to
Description H Citations the queue

Rating:
Science fiction uses the elements of real and exaggerated science to make a

story believable and Fantastic at the same time. Jules Yerne's Twenty (0 Ratings) RATE
Thousand Leagues Under the Sea is a good example of this tactic at work, Y K Ak (0Ratings) w

Copyright: 2006
Grades: Gr, 6-Gr, 8

Related Materials:
» There are no related materials for this item,

I" Curriculum Standards I

Playing and Downloading Full Videos and Video Segments
Discovery Education™ streaming videos are divided into "chapters" or "segments" so
educators can show the part that best relates to their teaching objective or lesson.

1. Play Video E

You can view a video segment "live" or stream in "real-time" by clicking on the Play
button. The quality of the video streaming experience will depend on many factors
including the speed of your Internet connection and the number of people at your
school who are online while you are streaming video content.

2. Download a Video @

When you download a video segment, you save a copy of the file on your
computer or local network for future access. To download a video or video
segment, right-click on the download icon (or Ctrl + click if using a Mac) and
choose "Save Target As..."
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3. Closed Captioning

Many Discovery Education™ streaming videos are available with closed captioning
(Windows Media Player only). To activate closed captioning, click the Media
Settings and check the box next to "Enable Closed Captioning."

Media Type Selection

:‘ ' Windows Media’ O QuickTime

@ 256 Khps 256 Kbps

Closed Captioning
¥ ESlEnatle closed Captioning (window media player only)

Player Selection
% Embed in Web Brawser ' Stand-alone Application

«&D €D

To download videos with closed captioning, first download the video following the
above instructions. Next click on the BAnext to the play and download icons to
download the closed captioning file. This file must reside in the same directory as
the video and the filename (before the .smi extension) must be identical to the
video filename.

D EHEBA the Theory of Unifarmitarianism (03:20) r

4. Add this clip to the queve

Your school has elected to use a Download Later software that allows you to queue
videos to download overnight to a local server. When playing a video that has
been Downloaded Later, it plays from the local server rather than the Internet,
allowing you to stream live video without using Internet bandwidth. As a result, you
will have more consistent video streams, shorter connection times, and overall
improved Internet speed.

1. Click the Add this clip to the queue icon next to any video or video segment.

2. A blue arrow indicates that a video has been queued and is waiting to
download overnight.

3. When the green checkmark appears the next day, the video is available.

Day 2

1. Log onto unitedstreaming and click on My Content. You can find your video in
Network Manager. If you added the video to My Content (playlist), you can also
locate it from your playlist.

2. Please Note: You can also email the video you selected to a friend.

3. Click on the play icon to show your video directly from the school server.
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4. If you want to download the video into a PowerPoint, burn to a CD or save onto
a flash, you will need to right click on the download button and choose Save
Target As.....

Shorten the title of the video before you save it in My Documents.

If you are creating a PowerPoint, make sure you save all your videos/clips in the
same folder in My Document

o O

Home Use:

Please note: You can use the download later icon at home. If you find a video that
you want to use at school, click on the download later icon. The network manager
will recognize the video and add it fo the queue. When you return to school the
next day, you can find the video in Network Manager.

Teacher Center in Discovery Education™ streaming

CLASSROOM TOOLS

Assignment Builder

Build and store assignments Far
wour students that use
Discovery Education™
Freamings curriculum content,

G0 To

CURRICULUM RESOURCES

Calendar

Quiz Builder

Incorporate wideo clips inko
interactive quizzes with
Discovery Education™
Fraaming Quiz Builder!

@G0 To

Lesson Plan Library

Writing Prompt
Builder

Give students writing practice
with these images that include
camposition prompks.,

@50 To

Thematic Focus

V-ﬂ

Browse weekly keaching topics
that include video seqments,
leszon plans, and student
ackivities.

@50 To

Tap into more than 200 lesson
plans designed for Discovery
Education™ sfreaming videos,

o | Help students connect the past
B and present with videos tied to
historical events,

G0 To @50 To

Discovery Education
Atlas

Inspired by Discovery
Channel's landmark Atlas
series, Discovery Education™
skreaming gives you a unique
video guide bo our world.

@ coTo

Displaying Videos Connected to a TV

Please note: You may need to use the hot key function: Control/Alt/1 in order to view the
video on the TV screen.

If TV is not displaying the video, please follow these directions:

1.

2
3.
4.
5

Start playing the video.

Right click on the video.

Choose Options.

Drag the video acceleration button into the middle.
Click Full Screen and video should display on TV.
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Appendices
Assignment Builder

unitedstreaming in Action:

Assignment Builder

| Assignment Builder

b sy i your perscnakond My Content s, To GOt Stated, crasts 3 new Assgnmant or browse the sample.

Assignment Builder is a versatile resource that helps you Fespe

build online activities and web-based projects that are F——— '"
stored on the untedstreaming servers. You can use this Comme] | o
tool to create student assignments that integrate a variety of i“_'"_'_“""l",:"_mi" o 221 e o - L=
digital media types. Students access assignments through Keymord: |7mm ‘.J..lw.—: arhemiioedt it
the Student Center. i e s ]

' schoct asngrenacss
¥ Crtrice pssnments
= I —

oo |

Creating a New Assignment

Access the Assignment Builder from anywhere on the site by clicking on Teacher Center in the navigation bar at the top ofthe
screen. To get started, click on “Create New” from the Assignment Builder home page and follow these easy steps:

Step 1of 5
General Information » Add Makerials » Material Inskruckions » Previgw » SURMR ALY

Step 1: General Information

Start by providing information about your assignment in the form provided. The assignment name, author, school, subject area,
and grade level are required fields. You can also create assignment instructions, leamning objectives and teacher notes.

You can save your assignment by clicking on the Save button at the

bottom of the screen. If you choose not to click Save, a warning q\%\qaming

message will appear on each step thereafter, until you click on the Tt appears you have not yet saved this Assignment to a Folder in your My Content area,
- . ‘ou may continue ba work on building your Assignment, but it will not be saved until you

Save button and select the folder within My Content to which you click on the "Save" button and specify a My Content Folder in which stare it

would like to save your assignment.
Step 2: Add Materials

Wiekcorme 16 tha Asagnmant Rulder - 3 toal to hal you creata Astonments for your etudents. Vour Asagrimants wil

You can add media to your assignment, such as video segments, animations or audio files. | il Activity Types

|.C|II Media Types
You can also add an activity such as a Quiz or Writing Prompt or add links to websites. all Media Tymes:

< TulalMedia Tvoes

el joy =
Writing Prompts

Video Segments
Images

Step 3: Material Instructions

Once you have selected media, activities and websites for your assignment, you can write Articles

step-by-step instructions that your students will see as they work with each material type. Eudiﬂt
el

Step 4: Preview Arirations

Clip &vk
The Preview feature allows you to see what your assignment looks like in its final form. If you wish to

make changes simply click on any of the steps in the process chain.
Step 5: Summary

The summary provides assignment information you will share with your students. When you provide the Assignment Code,
students will need to go to hitp:/Avww.unitedstreaming.com/studentcenter/ and enter the assignment code and their first and last
name in the fields provided. When you provide the Student Center Link, students are taken directly to unitedstreaming's Student
Center. The Assignment Code will be pre-populated and students simply enter their first and last name in the field provided.
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Quiz Builder

unitedstreaming in Action:

Quiz Builder

A4 Quiz Builder
R R . 5 . \\ jalcoma to the Guiz Dudsr - 3 tool to help you raate for vour students, Your wil b saved
Quiz Builder is a unitedstreaming tool that helps you Desanaead W Crtant 325 TG e, s e U 0 so0h i Al Loy e
produce interactive quizzes for your students to complete :_,m“"‘ . . . preeT—rp—
Quiczes, chadung Uross thal.
online, at their own pace. Measure comprehension at the SRR | | oot
end of a lesson, or assign a quiz at the beginning of a A il : : =)
. xisting Quizses inthe Quiz Library, enber one or ko ared ik b
project to find out what students already know. s N —— o 3kt e v
DisplaY: [ g cpirmns Grade:  [Seled... =] =]
P schonl Guizaes d

¥ Ditstrict urzes
¥ unkedstreaming Cuizees

Creating a New Quiz

Access the Quiz Builder from anywhere on the site by clicking on Teacher Center in the navigation bar at the top of the screen.
To get started, click on “Create New” from the Quiz Builder home page and follow these easy steps:

Stepl1ofs

General Information » Add Materials » Add Questions » Previaw » Summarsy

Step 1: General Information

Start by providing information about your quiz in the form provided. The quiz name, author, school, subject area, and grade
level are required fields. You can also create quiz instructions, learning objectives and teacher notes.

You can save your quiz by clicking on the Save button at the bottom of the
screen. |fy0u Choose no_t to CI Ic'_( SaVe, awarning message WI" appear on It appears you have not yet saved this Quiz to a folder in your My Content area,
each step th ereai’cer, Untll you ClICk on the Save bl.,ltton and Select the ‘fou may conkinue ko work on building wour Quiz, buk it will nok be saved unkil you

- . . . click on the "Save" button and specify a My Content: Folder in which store it
folder within My Content to which you would like to save your quiz.

Step 2: Add Materials
I.ﬂ.ll Media Tvpes

You can use the Keyword Search to add full videos and video segments to your quiz or search for video (A edis Tooes
content by Subject and Grade. Al Fodia Tvoes
Step 3: Add Questions

The Question Databank contains thousands of questions you can add to your quiz, or you can write your own questions.

& Warning

Step 4: Preview

The Preview feature allows you to see what your quiz looks like in its final form. If you wish to make changes simply click on
any of the steps in the process chain.

Step 3: Summary

The summary provides quiz information you will share with your students. When you provide the Quiz Code, students will
need to go to http:/Avww.unitedstreaming.com/studentcenter/ and enter the Quiz code and their first and last name in the
fields provided. When you provide the Student Center Link, students are taken directly to unifedsfreaming's Student Center.
The Quiz Code will be pre-populated and students simply enter their first and last name in the field provided.
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Writing Prompt Builder

unitedstreaming in Action:

Writing Prompt Builder

Writing Prompt Builder Stimulate the writing process in your . ‘E?é'.{::::("f:ww R s . 0o S S o WA
classroom with thousands of images that are ready-made for LT T i b
declarative, persuasive, narrative, and expository writing exercises. e | E:ijmm::”
You can search the Writing Prompt Library for images accompanied P ey [ |
by suggested text or create your own writing prompts with the help of e e, s e—l e |
the Writing Prompt Builder. e R, oY ]

P District trting Fromets.
F uniasiraaming Wiking Frangts

Creating a New Writing Prompt

Access the Writing Prompt Builder from anywhere on the site by clicking on the Teacher Center link in the navigation bar at the
top of the screen. To get started, click on “Create New" from the Witing Prompt Builder home page and follow these easy steps:

Step 1 of S
| ' Select Image .. Customize Text ‘ Prewview ' Surnmary:

Step 1: General Information

Start by providing information about your writing prompt in the form provided. The writing prompt title, author and school are
required fields. You can also select a subject area, grade level(s) and choose from four different types of writing exercises:
declarative, persuasive, narrative, or expository. These fields are not required, but they are useful if you decide to share your
writing prompt with others.

You can save your writing prompt by clicking on the Save button at the £ Warning

i i 1 It b b et caved e Whiting 2 k ko = belder i [y Ccrkent arz.
bottom of the screen. If you choose not to click Save, a warning message will e L T T R O )
appear on each step thereafter, until you click on the Save button and select S e e A SO S e

the folder within My Content to which you would like to save your writing prompt.

Step 2: Select Image

You can search from over 20,000 high quality, photographic images by typing a word or phrase in the Keyword Search or by
selecting a subject from the drop down menu. Preview an image by clicking on the thumbnail. When you find an image that you
like, click on the link “>>Add to my Writing Prompt.” Next, select the page orientation and border and then click the “Continue”
button.

Step 3: Customize Text

Wiriting Prompt Builder allows you to select the font type, style, size and color for the title and the caption. You can preview your
selections by clicking the “Preview” button. Once you have formatted your title and caption, click the “Continue” button.

Step 4: Preview

The Preview feature allows you to see what your writing prompt looks like in its final form. If you wish to make changes simply click
on any of the steps in the process chain.

Step 5: Summary

The summary provides writing prompt information you will share with your students. YWhen you provide the Wihiting Prompt Code,
students will need to go to hitp:/Awww.unitedstreaming.com/studentcenter/ and enter the Whiting Prompt Code and their first and
last name in the fields provided. When you provide the Student Center Link, students are taken directly to unifedstreaming’s
Student Center. The Whriting Prompt Code will be pre-populated and students simply enter their first and last name in the field
provided.

Technology Consulting Team 12
September 13, 2008



Viewing results of Quizzes, Writing Prompts, and Assignments

After you have your students complete a quiz, a writing prompt, or an assignment online,
you can view the results in two ways.

Receiving email notifications
When you create a quiz, writing prompt, or an assignment, you can select to receive an
email notification by checking off the box as shown in the picture below.

Quiz General Information .

Step 1 of 5 J
- Add Materials - Add Questions L Preview L J Assign *

To create an Quiz, you can start by providing the general information requested below:,

NOTE: * Indicates Reguired Field

-Hﬂ"‘"ﬁb -r—..h-""*‘- S PR, ..‘.a_'\_\_'-*'-...*“....\r‘-\ M

P — - P - o S = o a—- I
S - T L . ; . s e =gt =T T —

T e e
e et = et e~ . T et
‘-}_;Quiz Options: ¥  Receive an Email notification, when a student completes this Quiz,
'1‘.\ | Display quiz questions ko student in randam order,
;."' [T Present the quiz "guestion by question” instead of "all at once",
‘:\‘---_ [T allow student to view graded quiz (with correct answers revealed),
! [T Allow student ko take this quiz more than once,

Then, if a student completes the assignment, you will receive an email. Below is a sample
email notification.

Quiz: George Washington - User: Tom Smith

support@streaming.com |
Sent: Wed 9/17/2008 2:35 PM
To Plotkin, Sookhee K

Tom Smith has completed the quiz: George Washington
Tom Smith scored 1 out of 2 gradeable questions correct ( 30.0%)

The detailed grade report for this user and quiz can be viewed from the
Quiz Center in streaming.

Technology Consulting Team
September 13, 2008



Viewing the Detail Reports in My Content

To view the results, go to My Content. Use the View drop-down menu to select Quiz,
Assignment, or Writing Prompt and click the Go button. In this example, Quiz is selected.

Welcome, Sookhes | My Content || Teacher Center | Professional Development ,
Home = My Content

2 My Content w7 School Content J| "y District Content Network Manager Sharing Admiristrator

view: [quiz -] & | AddFolder | | add Contert |

My Content 07/31)2008
Type Mame Added Grade subject Action
(& Tom sawyer 09/17/200% & E”Q"Shﬁr‘z’s”g”age [copy =] _Ga |
O Tom Sawyer 09172006 Btos Health [cepy =] _Ga |
(@ seorge washington 08j26/2008 & E”g'iShLLri's”g“agE [copy =] _Ga |
@ Georgs Washington 039172005 5 English'{ql_r?:guage m il

Select the quiz that you want to see the results. Click the drop-down menu next to Copy
and select Grade Book. Then, click the OK button.

& My Content w School Content | “w" District Content § Network Manager Sharing Administrator
view: [quiz -] & | addFolder | add Contert |
. My Content 071312008
Type Mame Added Grade Subject A n
EnglishjLanguage
@ Tom Sawyer 09/17/2008 B ol o |
&) Tom Savwyer 09/17/2008  Glod Health Go_|
) English/Language
(&) eorge Washington 026/ 2008 & poted Go_|
) English/Language
@ George Washington 09172008 5 Arts Go |

You will see a list of assignment names (quizzes, writing prompts, or assignments). Click one
assignment name that you want to view.

Home= My Contert = Classroom Manager

Classroom Manager

‘Welcome to vour dassroom manager, & kool to help you
build and manage wour classrooms and assignments,

Assigned Materials By Code /URL

Assignment Name Type Action
®  George Washingtan e Quiz (remove)
*  George Washington Quiz ({remaove)
P Tom Sawyver Quiz {remaove)
®  George Washington Wriking Prompk (remaove)
Technology Consulting Team 14
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You will see alist of students who completed the assignment. If you wish to see how each
student did on the assignment, click the (view quiz) link.

Assigned Materials By Code /URL

Assignment Mame Type Action

¥ George Washington iz (remove)

Student Name Completed Staus Grade

allen, Jos 091808 complete 0% (wiew guiz)

plotkin, sookhes na/2ai0a complete 100 %% {view quiz)

Smith, Test 0917 /0& complete 100 %% wiew quiz)
¥ George \Washington iz (remave)

Student Name Completed Staus Grade

Srith, Tamm 0917105 complete 50 %% (view quiz)

Below is a sample student quiz summary.
Student: Tam Smith

KEY:
X Queskion Answered Incorrectly

v Correck Answer(s) You Selected

v Caorrect Answer(s) You Did Nat Select

##+ The Student scored a 50.0% on this guiz, *++

1. 1. Who is George Washington?
(Choose only one answer)

/ The first president of the United States

X ¥ hero

librian
conskructin worker

a0

teacher
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Closed Captioning

Closed Captioning

Up until recently, dosed captioning could only be streamed on a Windows machine, but now you can
alzo download them. Here are the directions for downloading the files.

Search for or focate a video with Closed Captioning

Us=ing the Advanced Search, type in a subject, select any other feature O Only Closed Captioned Titles
(optional), and select the “Closed Caption” option. Or, just look to see ifthe [l 5F_‘_ Only Spanish Titles
Closed Captioning icon 1= displayed on the Search Results. C] B oniy Editable Titles

Enabling the Closed Captioning Feature
If you see “My Preferences” in your menu next to “My Playlist”, click 1 T A T

on it and scroll to the bottom. Check “enable closed captioning™. WY o] o
If you do not see “My Preferences” in your menu, look at the top of the PlavarSalaction: (3} Emzaddsd £ Ssnd-alona
clip list and locate “Show Media Controls”. Click on it and check Ol Caplivning: )0 B30

“enable closed captioning”™.

Downloading the .asf and .smi files

The most important thing about downloading the closed captioning 15 make sure the two files have
exactly the same name except for the extension. If you have local hosting or Network Manager in place,
you will need to make sure to change the video file name to match your .zmu file.

Downloading the .smi file:
o n e Al Fleeho nns E:':] Ollce 37011 Jve enabIEd o

i P e Closed Captioning, you = OO curctecctor ouen T

will notice that the CC icons will appear next to each clip. OO oot o, TG
R R Generetra Fleesricys N4

Place your cursor over the icon of the clip you want to
download > right-click > Save Target As > choose a file location > Save the file. In this screenshot, the
sugpested file name 1s “Static_Electriaty sm1”

o ﬂ static Els 2y city (01104) [cd

Upan Link,
Cipen Link 17 e window

Downloading the .asf file:

Download the video file az you normally would, but make sure you have named the exactly the same as
the smi1 file. This account does not have Network Manager 1n place, so the process 15 samply to place
the cursor over the “D™ > right-click > Save Target As > rename the file 1f necessary to match the .smu
file > save 1t in the same folder.

Note: If Network Manager 15 in place, atter the clip has been downloaded, click on the Network
Manager link in the Menu to access the clips. When you locate the matching clip, place your cursor
over the “D” = right-click > Save Target As > rename the file to match the smi file > save it in the same
folder as the .smi file on your local drive.
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Adjusting the Settings in Windows Media Player

In Tools...
Go to the Menu (if 1t 15 not visible, maximize the Window) > Tools P || Do, | lme | Potoces | Vi vy
> Options > Security > Run seript command when present > OK. (If ) e e to s st connars e
you are using Windows Media Player 10, you will also need to

e
C‘heck “Local GaptionS”-) when present
O D nat Fun script commands and rich media streams if the Player is

running inside a Web page

In Play...
Go to the Menu > Play > Captions and Sthﬂes > On if Available
Audio and Language Tracks > - i

Capkions and Subtitles
Wolume on if Available Crl+Shift+C

Display Full Screen

Closed Captioning will drop off the screen when you go Full Screen with Windows Media Player 9, but
will display nicely with version 10. I've also noticed that the captions will display in embedded
PowerPoint slides if all the settings have been set in Windows Media Player.
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